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Overview

Stellar PST to MBOX Converter is the right tool, if you are looking at converting mails, contacts,
calendars from MS Outlook PST Mailbox to Mail (MBOX), Contact (VCF) and Calendar (ICS) Apps
respectively. Using this application, you can convert your MS Outlook mailbox including complete mail
body, attachments contacts and calendar items. You can preview converted mail items before saving and
importing them in Mail. The software converts your MS Outlook mailbox to Mail mailbox, without making
any changes to the folder organization of MS Outlook (PST) mailbox. Additionally you can import contacts

and calendars of converted files into Contact and Calendar Apps respectively.

What's new in this version?

e Provides preview of messages in 3-view format.

e Provides preview of contacts and calendars.

Key features of Stellar PST to MBOX Converter:

e Converts MS Outlook contacts to VCF for Contact App.

e Converts MS Outlook calendars entries to ICS for Calendar App.

e Converts Outlook PST Mailbox to Mail (MBOX).

e Converts mailbox while keeping the folder organization intact.

¢ Ability to search for PST Mailboxes using Find PST option.

e Supports conversion of mailboxes from MS Outlook 2013, 2010, 2007, 2003.

e Converts password protected PST Mailboxes.



Installation Procedure

Before installing the software, check that your system meets the minimum system requirements:

Minimum System Requirements:

Note:

Processor : Intel Processor
Operating System : Mac OS X 10.6 and above
Memory : 1 GB RAM

Mail must be configured to view your converted mailbox in MBOX format.

To install the software, follow these steps:

1.

2.

3.

Unzip StellarPSTtoMBOXConverter.dmg.zip file.
Double-click the DMG. This will mount a virtual volume - Stellar PST to MBOX Converter

Drag Stellar PST to MBOX Converter application from mounted virtual volume to Applications

folder.
To launch the software, double-click on Stellar PST to MBOX Converter in Applications folder.

Accept the License Agreement and the main window of Stellar PST to MBOX Converter software

is displayed

Note: To remove the software, drag and drop Stellar PST to MBOX Converter from Applications folder

to Trash.



Launching the Software

You can use any of the following methods to start Stellar PST to MBOX Converter:
o Double-click Stellar PST to MBOX Converter in Applications folder,

Or,
o Double-click Stellar PST to MBOX Converter desktop alias (if you have created one),
Or,

e Click Stellar PST to MBOX Converter icon in the dock (if it exists).



User Interface

Stellar PST to MBOX Converter software has a very easy to use Graphical User Interface. User
interface contains features required for conversion.

After launching the software, you will see the main user interface as shown below:
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User interface contains Menus and Buttons that let you access various features of the software with ease.



Menus

StellarPSTtoMBOXConverter Menu

About Stellar PST to MBOX Converter

Use this option to read more information about
StellarPSTtoMBOXConverter RICEEN[TE

the software.

About StellarPSTtoMBOXConverter
License Agreement License Agreement
Use this option to view the license agreement Check for Updates...

for the software.

Check for Updates Services >
Use this option to search for both, major and Hide StellarPSTtoMBOXConverter  $2H
minor updates for the software. Hide Others \C3$H

Quit Stellar PST to MBOX Converter

Use this option to quit Stellar PST to MBOX Quit StellarPSTtoMBOXConverter #Q

Converter.
File Menu
Find File
Tools Help

Use this option to Find files from list of available Find File 3%F '
volumes. Open File 38N

, Save File ¥#S |
Open File
Use this option to open the selected file.
Save File
Use this option to save your file at desired
location.
Tools Menu
Register
Use this option to register the software after Help
purchasing. Register...



Help Menu

Help Topics
Use this option to view the help

manual for the software.
Buy Stellar PST to MBOX Converter

Use this option to buy Stellar PST to
MBOX Converter

Email to Stellar Support
Use this option to send an e-mail to

stellarinfo.com.

View Support Section
Use this option to view support page of

stellarinfo.com.

Submit Enquiry
Use this option to submit enquiry to
stellarinfo.com.

View Knowledgebase Articles
Use this option to visit Knowledgebase
articles of stellarinfo.com.

Search |

Help Topics...

Order Stellar PST to MBOX Converter
Email to Stellar Support

View Support Section

Submit Enquiry

View Knowledgebase Articles



Buttons

Help

O
v

Open File
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Save File

Find PST

Click this button to open software help manual.

Click this button to start the conversion process.

Click this button to stop the conversion process.

Click this button to open the selected file

Click this button to save your file at desired location.

Click this button to select PST file.

Click this button to find specified PST file.



Ordering the Software

Click here to know more about Stellar PST to MBOX Converter.

To purchase the software online, please visit_http://www.stellarinfo.com/email-tools/outlook-to-apple-

mail/buy-now.php

Alternatively, click Buy Stellar PST to MBOX Converter in Help Menu to purchase the software online.
Select either of the methods given above to purchase the software.

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required

to activate the software.



Registering the Software

To register Stellar PST to MBOX Converter:
1. Select Register from Tools menu.

2. If you have the key, select | have a key to register the product from Stellar PST to MBOX
Converter dialog box and click OK. Enter the registration key and click OK to register the

software.
Or,

If you don't have the registration key, select | don't have a key to register the product to
purchase the software online. Once you purchase the software, you'll get the key required to
register the software.

3. If entered key is valid, Activation Successful message will be displayed. Click OK.
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Updating the Software

You can use the update option of Stellar PST to MBOX Converter to check and install the latest updates
for the application. This will help you keep your application up-to-date. To update the software, click
Check for Updates option in Stellar PST to MBOX Converter menu.

To update Stellar PST to MBOX Converter:
e Run Stellar PST to MBOX Converter.

e |n Stellar PST to MBOX Converter menu, Click Check for updates button.

o |If updates are available, Update window is displayed. Follow the next step. Else, if no updates

are available, a message showing There are no updates available is displayed.

e Click Update button to download the latest version. It may take few seconds to minutes to
download the files. After completion, Update successfully installed message appears. Click
OK.

Note: Updates are available in Full Version only.
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Stellar Support

Our Technical Support professionals will give solutions for all your queries related to Stellar products.

You can either call us or go online to our support section at http://stellarinfo.com/support/

For price details and to place the order, click http://www.stellarinfo.com/email-tools/outlook-to-apple-

mail/buy-now.php

Chat Live with an Online technician at http://www.stellarinfo.com/

Search in our extensive Knowledgebase at http://www.stellarinfo.com/support/kb/

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php

E-mail to Stellar Support at support@stellarinfo.com

Support Helpline

Monday to Friday [24 Hours a day]

USA (Tollfree- Pre Sz_ales +1-877-778-6087
Queries)

USA (Post Sales Queries)  +1-732-584-2700
UK (Europe)  +44-203-026-5337
Australia & Asia Pacific  +61-280-149-899

Netherlands Pre & Post Sales
Support
Worldwide  +91-124-432-6777

Email Orders  orders@stellarinfo.com

+31-208-111-188
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Select PST Mailbox

To select a PST Mailbox:

e Launch Stellar PST to MBOX Converter.

e In Stellar PST to MBOX Converter, click Select PST button to select the PST Mailbox you want
to convert.

6 StelarPSTIoMBOXConverter File Tools Help

& °

e

Select PIT
e NIt P ey -

Fintd 5T
To Convert Outiook malibox (PST), follow the steps mentioned below

1. Click Select ST button to seiect Outiook malbox (ST) or chick Find
PST betton to fund mailbox

2. Chck ) Bumion 10 ST CONMVErbon

Cose

Ty — o |

Stellar PST to MBOX Converter allows you to search for a PST Mailbox, in case you don't know its
location. You can search for a mailbox in mounted drives or folders. However, you can select only one

volume at a time to search for a PST Mailbox.
To search for a PST Mailbox:

e Click Find PST either from File menu or from the main user interface. Find PST dialog box opens.

e Select the required volume from the Look in list box or click Find in Folder to search for the PST

Mailbox within a specific folder. Click Start to start searching for PST Mailbox.

o After the search is complete, mailboxes found in the selected volume / folder is shown in Find PST

dialog box as shown below:
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Find PST -

Look In | [ /Volumes/free space/office 2010 PST : | LS )
Find in Folder Stop
Name Size Created
[Volumes /free space/office 2010 PST/123. b Thu Jul 3 10:21:40 2014
/Volumes /free space/office 2010 PST/42078/o0... 2CB Thu jul 3 10:22:57 2014
/Volumes/free space/office 2010 PST/AHRI/per... 1CB Thu jul 3 10:54:13 2014
[Volumes/free space/office 2010 PST/My Outlo... SGB Thu Jul 3 10:24:59 2014
/Volumes /free space/office 2010 PST/My Outlo... 1CB Thu jul 3 10:25:36 2014
[Volumes/free space/office 2010 PST/My Outlo... 5CB Thu jul 3 10:28:02 2014
/Volumes /free space/office 2010 PST/Outlook ... 1GCB Thu jul 3 10:28:24 2014
[ ok Clear List | . Close

e Select the Mailbox you want to convert and click OK.

Note: Click Clear List to clear the list of PST Mailboxes found in the selected volume.
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Convert & Save Files

To convert a PST Mailbox:

e Click Save File button from toolbar of the application.
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e |n Select Destination Path, click Choose button to save the converted MBOX file.

Fie Tools Melp

g B s o

v B lem 'h S
v 7 0 sewonton B0 R Ontags it Tour Mamen
oD A vessages B e maheg Swesforce
o e Seres e 2 I e trvwm Champrr e
¥ (D) Tew o Prsena Futers R N
< 1T O mamsii DR S wseterre o et pe
= T Wt Bt of (e
. —— Y e L
e bess memailh
3 pwrnat =
£3 s w Saving = progrens. Passe aes.
£ Taa 2
B oreman
£ mss reetecny _
7 0 Comvmrnamen Acven e .
) Qs Samp Semingn 4
2 soopmmicomumncrs | —
T pent mateny
T s font
O
< W Comernin
7 L Comam
o [0 e commaos e
o meectamwas

i®

Once saving process is complete, converted file will be saved at the specified location.
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Import MBOX files to Mail
To import MBOX files to Mail:

e Open Mail.

e From File Menu, select Import Mailboxes.

_Edit  View Mailbox Message

New Message #N
New Note ~3#EN
New To Do N®Y
— New Viewer Window X#N
MAILBOXES e 0 )
1 lnbox JROCH Vit 14
- Drafts.  Close rW
./ Sent Save S
v § Trash
@ oaf Save as Station
' chan At
¥ ON MY MAC
» | Impornt
: e ::::: Add Account...
< - o Import Mailboxes
oo ' Add RSS Feeds...
» Imports
L) ll'lipoﬂlI Print ¥ D

e InlImport dialog box, select Files in mbox format and click Continue.

Jmpoct,

Import data from:

(I Netscape/Mozilla
() Thunderbird

| ) Eudora

() Files in mbox format

You will now be asked for the location of one or more
files in mbox format or a folder containing them. These
files’ names might not end with ".mbox".

Cancel | |- Continve |

The selected mailbox will be imported to Mail. Click Done to view the mailbox.



Import Contacts to Contact App

To import contacts to the Contact app, follow the steps given below:

e Click on Go menu and select Applications from there select Contact. Alternatively you can also
double click on the Contact app from Dock to open it.

e From the File Menu select Import option.
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e A directory list opens. From the directory list browse to the folder from where you want to import
the converted files.

e In the folder open the mbox file and then open Contact.

e Select the VCF file that you want to import.

! Contacts File Edit View Card Window Help
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e Click Open.
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A dialogue-box opens click on Add.

‘ Are you sure you want to add 79 cards?

? Cancel [ Add ] {
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Import Calendars to Calendar App

To import calendars to the Calendar app, follow the steps given below:

e Click on Go menu and select Applications from there select Calendar. Alternatively you can
also double click on the Calendar app icon from Dock to open it.

e From the File Menu select Import option.
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00 New Deent xN Calenda o
Calendars | | 4 New Calendar KRN | Dy Ween Your | Q
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e A directory list opens. From the directory list browse to the folder from where you want to import
the converted files.

¢ In the folder open the mbox file and then open Calendar.

e Select the ICS file that you want to import.

aNals) Calendar: import
« » (12 S = =~ G2Calendar :] (a
L3 Al My Files - 000000 pst ’ - Contact ’ a Deleted Rems.ics
=T & 000000.pst (1) ’ L Contact Search L LosthFound ics
i Avplications G Catendar Events * | [ emProcSearch ’
i Top & Comtacts ’ ol LosthFound
'11 Documents & dmg pat tombox . &l Search Root
F T grigor_2.mbox » Ll SPAM Search Folder 2
© Downloads G ey * | [ Top of Outicok data e *
DEVICES il KeyCenerator »
2 mac_1.mbox
- o d Mails
o Lion L mbox ’
e mMountain lion 9 ax?m.!m ’
L snow leopard e ey

o free space

AHARID

Cancel | | import |
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Click Import.

A dialogue-box opens click on OK.

_Add event

Adding a new event

This calendar contains a new event. Please select a destination
calendar:

| @ Home :

| Cancel | [ OK |
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FAQs

1. What can | do with the demo version of this software?

22

Using demo version of the software you can only preview emails, contacts and calendars but
cannot open attachments. To open your attachments you need to purchase and activate Stellar
PST to MBOX Converter. The saved file will be named as Pst name_(current_date,

current_time).mbox".
What is MBOX file format?

The MBOX file is the most common format for storing email messages on a hard drive. All the
messages for each mailbox are stored as a single, long, text file in a string of concatenated e-mail

messages, starting with the From header of the message.
Is it necessary to install MS Office before using Stellar PST to MBOX Converter?
You don't need MS Office on your Mac to use the software.

If the location of PST files are not known, can | search for then using Stellar PST to MBOX

Converter?

Yes, Stellar PST to MBOX Converter lets you search for PST files in specified volume of your

Mac. To know how to use this option, please refer Select PST Mailbox topic of help manual.
Can | convert a single mail into MBOX file?

You can only convert a complete mailbox.

Can | convert multiple PST files simultaneously?

You can only convert a single PST file at a time.

Can | convert an encrypted or password protected PST files as well?

Yes, you can convert encrypted or password protected PST files as well using Stellar PST to

MBOX Converter software.



Legal Notices

Copyright

Stellar PST to MBOX Converter software, accompanied user manual and documentation are copyright
of Stellar Information Technology Private Limited, with all rights reserved. Under the copyright laws, this
user manual cannot be reproduced in any form without the prior written permission of Stellar Information
Technology Private Limited No Patent Liability is assumed, however, with respect to the use of the

information contained herein.

Copyright© Stellar Information Technology Private Limited. All rights reserved.

Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is subject

to change without notice.

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH
REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY
EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR
ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR
INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES
INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS
OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND
THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED,
BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES,
WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION
WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE
THEREOF.

Trademarks

Stellar PST to MBOX Converter® is a registered trademark of Stellar Information Technology Private
Limited

Mac OS X® is a registered trademark of Apple Computers.
Microsoft Outlook® is a registered trademark of Microsoft.
All Trademarks Acknowledged.

All other brands and product names are trademarks or registered trademarks of their respective

companies.
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License Agreement

Stellar PST to MBOX Converter
Copyright © Stellar Information Technology Private Limited INDIA

www.stellarinfo.com

All rights reserved.
All product names mentioned herein are the trademarks of their respective owners.

This license applies to the standard-licensed version of Stellar PST to MBOX Converter.

Your Agreement to this License

You should carefully read the following terms and conditions before using, installing or distributing this
software, unless you have a different license agreement signed by Stellar Information Technology Private
Limited

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or
use any copy of Stellar PST to MBOX Converter with which this License is included, you may return the
complete package unused without requesting an activation key within 30 days after purchase for a full

refund of your payment.

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of
Stellar PST to MBOX Converter. For purposes of this License, if you have a valid single-user license,
you have the right to use a single Licensed Copy of Stellar PST to MBOX Converter. If you or your
organization has a valid multi-user license, then you or your organization has the right to use up to a
number of Licensed Copies of Stellar PST to MBOX Converter equal to the number of copies indicated

in the documents issued by Stellar when granting the license.

Scope of License

Each Licensed Copy of Stellar PST to MBOX Converter may either be used by a single person or used
non-simultaneously by multiple people who use the software personally installed on a single workstation.

This is not a concurrent use license.

All rights of any kind in Stellar PST to MBOX Converter, which are not expressly granted in this license,
are entirely and exclusively reserved to and by Stellar Information Technology Private Limited You may
not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative works
based on Stellar PST to MBOX Converter nor permit anyone else to do so. You may not make access
to Stellar PST to MBOX Converter available to others in connection with a service bureau, application

service provider or similar business nor permit anyone else to do so.
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Warranty Disclaimers and Liability Limitations

Stellar PST to MBOX Converter and all accompanying software, files, data and materials are distributed
and provided AS IS and with no warranties of any kind, whether expressed or implied. You acknowledge
that good data processing procedure dictates that any program including Stellar PST to MBOX
Converter must be thoroughly tested with non-critical data before there is any reliance on it and you
hereby assume the entire risk of all use of the copies of Stellar PST to MBOX Converter covered by this
License. This disclaimer of warranty constitutes an essential part of this License. In addition, in no event
does Stellar authorize you or anyone else to use Stellar PST to MBOX Converter in applications or
systems where its failure to perform can reasonably be expected to result in a significant physical injury or
in loss of life. Any such use is entirely at your own risk and you agree to hold Stellar harmless from any

and all claims or losses relating to such unauthorized use.

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special,
incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss
of business profits, business interruption, loss of business information, or any other pecuniary loss)
arising out of the use of or inability to use the software product or the provision of or failure to provide
support services, even if Stellar Information Technology Private Limited has been advised of the
possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability

under any provision shall be limited to the amount actually paid by you for the software product.

General

This License is the complete statement of the agreement between the parties on the subject matter and
merges and supersedes all other or prior understandings, purchase orders, agreements and
arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive
jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the
State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries
of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any
violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or

future violation of the same provision or any other provision of this License.

Copyright © Stellar Information Technology Private Limited. All rights reserved.
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About Stellar

Stellar Information Technology Private Limited is a trusted name in the field of Data Recovery and Data

Protection Software for more than a decade.

We provide the widest range of Data Recovery Products. Our range includes Data Recovery Software for

almost all Operating Systems and File Systems.

Product line:

Data Recovery

A widest range of data recovery software that helps you recover your valued data lost after accidental
format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >>

File Recovery

The most comprehensive range of file undelete and unerase software for Windows and MS office repair
tools. More Info >>

Database Repair

A wide range of database repair software to help you repair corrupted Microsoft SQL Server database,
Microsoft Access database, MySQL database, Oracle database, SharePoint Database, SQL Anywhere

Server and Interbase database. More Info >>

Email Recovery

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook
Express and MS Exchange useful in instances of data loss due to damages and corruption of Email.
More Info >>

Data Protection

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure

complete data protection against hard drive crash. More Info >>

Data Sanitization

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives,
System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser
utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >>

For more information about us, please visit www.stellarinfo.com
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